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Introduction Objectives 
 
 

This manual is written to give you a step-by-step guide for your 
classroom training and a handy reference for your daily work. In 
this Introduction, you will learn how to use this training guide 
effectively. This section covers the following topics: 
 

• An introduction to the Crystal Reports application 

• Pre-Qualification Exercise 

• Class objectives 

• Help with using this training guide 

• Information on how to start the program 
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About Crystal Reports 
 

In today's information intensive environment, every business has a database 
of some sort. After all, business today is all about information and databases 
give you a handle on the massive amounts of information you must deal with. 
Therefore, your business has a database and from that database, you need 
reports. The problem is, most reporting capabilities that come with database 
programs are limited. They only report on data from that program. Many 
users need to report on data from multiple sources, even databases that are 
in SQL (Structured Query Language), such as Oracle, Microsoft SQL Server, 
Informix or Sybase.  
 
Crystal Reports is one of the most powerful reporting programs available with 
the ability to pull data from all types of data sources. You can use Crystal 
Reports to generate reports from any of the standard PC database programs, 
Access, Paradox, or FoxPro, as well as from a mainframe or server 
database. Crystal also has a powerful web-reporting server that allows you to 
distribute your reports over the web.  
 
Crystal Reports is bundled with more than 160 other programs including 
Visual Basic, some medical applications, many accounting packages and 
several ERP solutions.  It makes report generation easy without requiring you 
to be a programmer or a database expert. If you know how to work in a 
Windows environment and are familiar with the data you want to use, you can 
create a Crystal Report that looks professional and makes sense. 
 

Training Philosophy
 
Studies show that people retain 10% of information they see, 20% of 
information they hear, 50% of what they see and hear, and 80% of what they 
see, hear and do. In line with this, this class utilizes a hands-on method of 
training. You will see the effects of new procedures on the screen, hear the 
instructor explain how and why to use features, and perform the actions 
yourself as you learn.  
 
In addition, this class focuses on your ability to perform tasks using the most 
productive techniques. The manual may contain several methods of 
accomplishing a certain task. However, class time does not allow for practice 
of all methods for each task. Your instructor will guide you in the most 
effective method of performing a task, but inform you of other methods that 
are available. 
 
Questions are encouraged. While we give our best effort to explain new 
concepts in understandable terms, you may need to hear the concept again 
or have it explained more thoroughly.  Please let the instructor know when 
you need more information! 
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Pre-Qualification Exercise for the Designer 2 Workshop 
  

Why Should You Pre-qualify Yourself for the Designer 2 
Workshop? 
 
The Crystal Reports Designer 2 Workshop is designed for the experienced Crystal 
Reports user. It covers the more complex and powerful features of the program. 
The class discusses very technical issues and includes several fast-paced, 
comprehensive exercises. Our instructors have years of experience helping 
students to get the most out of their training. However, it is not always possible in a 
high level workshop to assist students with basic tasks. 
 
In order to maximize the benefit you receive from the Crystal Reports Designer 2 
Workshop, you should come into the training with a certain skill level. We assume 
all students who sign up for this workshop have a comfortable level of 
understanding in regards to relational databases. Students should also be able to 
perform the following tasks in Crystal Reports: 
 

• Create a new report, insert fields, save the report and refresh the data. 
• Add multiple tables to the report using the Data Explorer. 
• Use the select expert to pull only the data needed from the database. 
• Insert groups and summarize fields within the group. 
• Perform formatting tasks. 
• Create, save and use formulas in the report. 

 
If you would like to evaluate for yourself whether this is the correct level course, 
take our self-evaluation exercise. The exercise consists of writing a report in 
Crystal Reports. When you are finished, compare your report to the one our 
experts have done to see how well you understand the basic features of Crystal 
Reports. You can obtain the exercise and the results report from the Vision Harvest 
web site, www.visionharvest.com, or by e-mailing us at sales@visionharvest.com. 
 
If you have trouble creating the report or getting the correct results, or if you cannot 
perform some of the above-mentioned tasks, then we strongly recommend that you 
take the Crystal Reports Designer 1 Workshop before attending the Designer 2 
Workshop. By assuring you are well prepared for the Designer 2 Workshop, you 
maximize the benefits you receive from this in-depth look at advanced report 
writing. 
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Pre-qualification Exercise 
 
Using the Xtreme sample database that ships with Crystal Reports, create a report 
invoicing customers for each order. The report needs to show the customer billing 
address, the PO#, the sales person, the order date, the requested date, the ship 
date and the company shipping the order. The Details section should list the 
product ID, the product name, size/color, the unit price, the quantity, and the line 
item total. 
  
Select only those orders with an Order Amount greater than zero and with a ship 
date between January 1, 2004 and March 31, 2004. Group on the Customer ID, 
then on the Order ID. Display each order on its own page. Sum the line item total 
amount for each Order ID. Calculate the sales tax for the order at 6% and total the 
subtotal and sales tax. 
 
You will need to pull data from the following tables: 
 
Customer  Product 
Orders   Product Type 
Orders Detail  Employee 
 
You will need to create the following formulas: 
 

• Line Item Total that multiplies the unit price times the quantity for each 
product ordered 

• Sales Tax that multiplies the sum of each line item total times 6% 
• Order Total that adds the sum of each line item total and the sales tax 
• Product Description that contains nested if…then….else statements to 

show the Size field if the Color field is empty, the Color field if the Size field 
is empty, and both fields, separated by a comma, if both contain data 

 
You will need to create the following text boxes: 
 

• An address box with the text To: then the company name, the address, the 
city, region postal code and country 

• An employee box with the employee first name, a space, then the last 
name 

 
Format the report to look like the illustrations on the following pages: 
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Class Objectives 
This class is a performance based instructional system. It is geared to 
provide you with the tools you need to build and distribute reports the 
quickest, most efficient way. After completing this course, you will be able to 
perform the following tasks: 
 
• Refresher Exercise 

• Use multiple sections in reports for advanced formatting techniques 

• Underlay graphics and charts to print beside data 

• Calculate running totals in reports 

• Develop parameter fields to prompt users for information 

• Limit user entry into parameter fields 

• Understand Crystal Reports data handling and Evaluation Time functions 

• Comfortably make use of variables in formulas 

• Work with arrays and control structures in formulas for more flexible 
decision making 

• Use additional reports within a main report as subreports 

• Create linked subreports to tie data from another report to the current 
report 

• Format subreports to display on demand only 

• Customize groups in the report with formulas and custom names and 
create hierarchical groups 

• Perform group selection based on summary field values 

• Create and format Cross-Tab reports and create charts from Cross-Tabs 

• Working with Report Alerts 

• Creating and using Report Templates 

• Solve table link problems with advanced linking techniques 



 
 

9 

Crystal Reports XI Designer 2 Workshop ©2006 Vision Harvest, Inc.
Introduction 

About This Manual 
Each section of this manual contains objectives to provide you with the 
overall goals for the lesson.  Lessons have descriptions of features and 
concepts followed by systematic directions for completing a specific task. 
Each section ends with a challenge exercise to help you practice the skills 
you learned in the lesson. Challenge exercises provide you with tasks to 
accomplish. Try to complete these exercises on your own.  
 
As you work in this Training Guide, certain conventions are used to identify 
specific procedures. Use the following table as a guide: 
 

 
Training Guide Conventions 
Item Illustrated As 
Menu Commands Underlined letters for accessing menu commands are shown: 

 
Example:  File/Open 

Command Buttons Commands in dialog boxes are shown as buttons: 
 
Example:  
 

Categories, Radio 
Buttons, Text Boxes, 
Check Boxes 

All options within dialog boxes are listed in italicized text: 
 
Example: the Keep Group Together check box 
                 the Other radio button 

Keystrokes Keyboard keys are indicated by uppercase text: 
 
Example: press ENTER 
 
Keyboard combinations are shown in uppercase text with a plus sign 
(+) between the keys that need to be pressed simultaneously.  
 
Example: press CTRL + S to save 

Toolbar Buttons Toolbar buttons are indicated by the button name and a graphic 
image of the button: 
 
Example:  click the Print          button   

Typing or File Selections Text to be typed or file names to be selected are printed in bold 
letters: 
 
Example:  type Henry 
                 select grouping.rpt 

Exercises Step-by-Step exercises in the text are indicated by bold text and the 
 symbol. 

 
For example:   Exercise  - Format Objects 
 

ENTER
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Tips, Notes, and Warnings 
 
Tips, notes and warnings display with the following icons. Text for these 
additional comments display in bold and italics. 
 
 

This icon indicates a TIP or shortcut. 
 
 
 

This icon points out a NOTE of additional information. 
 
 
 
This icon calls attention to a WARNING or very important 
note. 
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Lesson Objectives 
 

After completing this lesson, you will be able to: 
 
• Plan and Create a report from a set of business requirements 

Review the techniques needed to plan and create a report 
 
• Add multiple groups to reports 

Create groups within groups to subdivide your reports how you want 
 
• Summarize different group levels 

You can effectively summarize information at any group level or all 
group levels 

 
• Insert simple lines and boxes for formatting 

Make reports professional and attractive with graphical features 
 
• Utilize the Repeated Group Header feature 

Add a "Continued…" message when a group prints across pages 



 

 17

Crystal Reports XI Designer 2 Workshop ©2006 Vision Harvest, Inc.
Lesson 1: Refresher Exercise 

Review of Planning a Report 
 

To make the report creation process efficient, you must plan the report. A 
little work up front before you ever open Crystal Reports can save a lot of 
time putting the report together.  It can also save problems caused by 
adding incorrect tables to the report, which can affect the accuracy of the 
records displayed.  
 
You must look at the business requirements for the report and decide what 
fields you need and the tables in which they are located. It is also helpful to 
look at things such as groupings, whether you need Cross-Tabs, fields 
needed for formulas and selection criteria.  
 
Suppose someone asks you to create a report based on the Xtreme 
Sample Database 11. Below are the business requirements for the report: 
 
The person requesting the report needs to see monthly customer sales by 
Supplier and Product Type. They want the Order ID, the Product Name, the 
line item Unit Price and Quantity and a total for the line items. 
 
• They want the sales amounts summarized for each supplier, product 

type and month. 

 
• They only need to see sales for 2004. 

 
• Some of the groups are large enough to display on more than one 

page. They want the Supplier Name and Product Type repeated at the 
top of each page. If the Product Type group continues from the previous 
page, they want the word "Continued…" to print. 

 
• The person requesting the report has supplied you with a printout of 

what the report should look like.  See the sample on the next page. 
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To create this report, first determine which fields you need.  
 
• For the Detail section, you need the Order ID field, Product Name field, 

the Unit Price field and the Quantity field 

• For the Line Total formula, you need to multiply the Unit Price field and 
the Quantity field   

• For grouping, you need the Supplier Name, the Product Type Name, 
and the Order Date. 

• Finally, you need to select orders from 2004 based on the Order Date 

 
Next, decide which tables you need to add to get the required fields. 
 
• The Supplier Name field is in the Suppliers table 
• The Product Name field is in the Products table 
• The Order ID and Order Date fields are in Orders 
• The Unit Price and Quantity fields are in Orders Detail 
• The Product Type Name field is in the Product Type table 
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Since the Supplier Name is the main grouping, the Suppliers table should 
be the Primary table. From there you want to link Suppliers to Products with 
the Supplier ID field, link Products to Orders Detail with the Product ID field, 
link Orders Detail to Orders using the Order ID field, and finally, link 
Products to Product Type using the Product Type ID field. 

 

Creating the Report 
 

Since you have given this some thought and figured out the tables and the 
links, adding the tables in the correct order and creating the links is easy. 
The links should look like the following illustration: 

 

 
Remember you can add multiple tables to a report from the Database 
Expert. You work with links using the Links tab on the Database Expert. 
The Database Expert is accessed under the Database menu or by 
selecting the Database Expert  button on the Expert Tools toolbar. 

 
The order in which the tables are displayed in the Link tab is based on 
the order in which the tables are selected on the Data tab. i.e. if 
Supplier is selected first; it becomes the first table on the Link tab.  
The order and links of the tables can be manually changed once they 
are displayed in the Link tab. 
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Placing Fields on the Report 
 
Remember you have five ways of placing fields on a report. Select the field 
in the Field Explorer, then: 
 
• Click the Insert button, and then click in the report 
• Double click the field, and then click in the report 
• Press ENTER, and then click in the report 
• Drag the field to the report 
• Right mouse click, choose Insert to Report from the short cut menu, and 

then click in the report 
 
Remember, when you place a field in the Details section, Crystal Reports 
adds a detail field title in the Page Header section and aligns the field and 
field title with a guideline. You can drag the guideline marker in the ruler to 
move the field and its title together. 
 
Now that you have planned the report, you are ready to use Crystal 
Reports to create the report. 
 

 Exercise 1.0  - Begin the Monthly Sales by Supplier and 
Product Type Report and Link the Tables Needed 

 
1. Start a new report as a blank report. Open the Create a New 

Connection folder then the ODBC (RDO)  data sources and the 
Xtreme Sample Database 11 data source. No password is needed to 
access this database. Add the tables indicated by the business 
requirements. Right click on the data source and select Add to 
Favorites as we shall be using this database throughout the class. 

 
2. The Auto-Link feature should link the tables automatically.  Clear the 

links and do them yourself. 
When you are finished the links should look like the illustration on the 
previous page. 

 
3. Add the appropriate fields to the Details section. 
 
4. Change the Printer Setup to a Portrait page layout, if necessary. 

Change the margins to be .5” on all four sides. 
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Creating the Formulas 
 
You are also going to need two formulas for this report. It can be helpful to 
write out the formulas during the planning stage to be sure you have 
accounted for all necessary fields. The formulas you need for this report are 
as follows: 
 
@Line Total  
{Orders_Detail.Unit Price} * {Orders_Detail.Quantity} 
 
@Continued 
          If InRepeatedGroupHeader then “ Continued...." 
 
 
Remember formulas are created from the Field Explorer dialog box. Select 
Formula Fields, and then click the New  button. After naming the formula, 
the Formula Editor dialog box opens providing you with three lists to select 
fields, functions and operators. 
 

 Exercise 1.1 – Create the Formulas and Add to the Report 
 
1. Select Formula Fields: in the Field Explorer dialog box, then click the  

button. 
 
2. Name the formula Line Total and select OK. 
 
3. Create the formula shown above. 
 
4. Add the formula to the report Details section after the Quantity field. 
 
5. Create the Continued formula, but do not add it to the report yet. 
 
You will add this formula later to display a "Continued" message in the 
group header.  
 

NOTE: The InRepeatedGroupHeader function is a function in 
the Print State category. Click the + sign to the left of Print 
State in the middle list in the Formula Editor, and then scroll to 
find the function. Double click the function to add it to the 
formula. 
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Advanced Grouping 
 
You can group data by using the Insert/Group… command or by clicking 
the Insert Group button  on the Insert Tools toolbar or the Group Expert 
button  on the Expert Tools toolbar. This report requires an Order Date 
group nested inside a Product Name group, nested inside a Supplier Name 
group as shown in the Group Expert illustration below. 
 

 
 
As you create groups, Crystal Reports nests each group inside the previous 
one you created. However, you can reorder groups in any order you want. 
To reorder groups, click the Group Header section name at the left of the 
Design screen, for the group you want to move. The group header and 
footer sections are highlighted. Drag the group to the new location. The 
mouse pointer changes to a grabbing hand as you drag.  In the Group 
Expert shown above you simply move the group headers using the arrows 
in the top right of the window 
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TIP: When you group on a date field, Crystal Reports allows 
you to define the period for which the date is broken down; 
i.e. monthly, yearly, quarterly, etc. A third drop-down list 
appears automatically in the Insert Group options dialog box 
allowing you to specify when the group is printed. 

 
 

 
 
Remember you can summarize any field by RIGHT clicking it, then 
choosing Insert Summary… You must specify the type of calculation you 
want Crystal Reports to perform and the group at which you want the 
summary to appear. 
 

 Exercise 1.2 – Create groups and summarize the Line Total 
field 

 
1. Open the Group Expert window using the Group Expert  button. 

Create a group on the Product Type Name field. Turn on the Repeat 
group header on each new page feature by selecting the Options button 

 
2. Create a second group on the Supplier Name field. Also, turn on the 

Repeat group header on each new page feature.  
 
3. The report requirements call for the report to display information by 

Supplier Name and then Product Type. You need to change the order 
of the groups. Select the Product Type Name field in the Group By 
window of the Group Expert (  ). Select the Down Arrow to reorder the 
groups. 
The Supplier Name should be the first group in the Group Expert with 
the Product Type name nested underneath. 
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4. Create a third group on the Order Date. Choose to print the section for 

each month. Using the Options tab check on the Keep Group Together 
item. 

 
5. Create a summary for the Line Total column. You will need to do this 

three times, once for each group. 
All the summary fields should automatically line up on the guideline to 
which the field is attached. 

  

 
 
 

Selecting Certain Records 
 
Remember Crystal Reports pulls all records from the database unless you 
filter the records based on some criteria. The business requirements for this 
report requests only records from the year 2004. To specify this, use the 
between operator and specify all records with an order date range 
beginning 01/01/04 and ending 12/31/04. 
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 Exercise 1.3 – Select records with an Order Date in 2004 
 
1. Make sure there are no fields selected on the report, and then click the 

Select Expert  button on the Expert Tools toolbar.  
 
2. Choose the Order Date field. 
 
3. Choose the is between operator. 
 
4. In the first drop-down list, select 1/1/2004 12:00:00AM. 
 
5. In the second drop-down list select 12/31/2004 12:00:00AM. Click OK 

when finished.  
  
6. At this point save and preview the report. Name the report Monthly 

Sales by Supplier and Product Type.rpt 
 

Helpful Hints for Formatting the Report 
 

Adding and Working with Text Objects 
 
Once you have created a group, you can delete the group name field from 
the group header without affecting the grouping. You can delete the 
Supplier Name and Product Type Name fields from Group Headers #1 and 
#2, and then create a text object in Group Header #2 containing the 
Supplier Name and Product Type Name.  
 
Remember text objects can contain text you type and fields from the report. 
You can add a field to a text object by dragging the field from the Field 
Explorer dialog box into the text object. Once you have a field selected, the 
mouse pointer changes to an arrow with a + sign when you are pointing into 
a text object. You can also move a field from the report into a text object. 
The text object must be in Edit Mode (flashing insertion bar in the text box 
and a small ruler in the horizontal ruler at the top of the report). 
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Also remember you can format all or part of a text object: 
 
• To format the entire text object, select the object (there are handles 

around the object) then apply the formatting 
 
• To format part of a text object, double click the object to enter Edit 

Mode, and then select the part you want to format. When the part is 
highlighted, apply the formatting 

 
• To format a field inside a text object, double click the object to enter Edit 

Mode, and then click on the field. Once the field is highlighted, apply the 
formatting 

 
Hiding and Suppressing Sections 
 
Remember you can hide or suppress sections in a report by RIGHT clicking 
on the section name in Design view and choosing the appropriate 
command. Hiding a section causes the section to not display in the Preview 
tab. However, users can double click summaries to display hidden details. 
Suppressing a section causes the section to not display without any options 
for viewing it. A hidden or suppressed section will be grayed out in the 
Design tab. 
 

Guidelines 
 
As a reminder, you can add horizontal guidelines to the rulers at the left of 
each section and snap the tops or bottoms of objects to the guidelines to 
horizontally align them. 
 
 

 Exercise 1.4 - Format the Report 
 
1. Return to the Design view. It is easier to add and format objects from 

Design view. 
 
2. Add the title and format as you see it in the sample report on page 28.  

Add the Xtreme logo (included in class files) to the right side of the 
Report Header. 

 
3. Delete the Group #1 Name and Group #2 Name fields from Group 

Headers #1 and #2. 
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4. Using the sample report as a reference, create a text box in Group 
Header #2. Type the text Supplier Name: then add the Group #1 
Name: Supplier Name field from the Group Name fields in the Field 
Explorer. On the second line of the text object, type the text Product 
Type: then add the Group #2 Name: Product Type Name field. 
Format all objects in the text box to Bold. You may need to resize the 
text box. See the sample on the next page for final formatting.  
HINT: Format the text object border rather than drawing a box around 
the object. It is easier and you only have one object to deal with, plus if 
you resize the text object the border will grow with it whereas a box will 
not. 

 
5. Suppress Group Header #1. It no longer contains anything you need to 

see in the report.  
 
6. Add a text box to the Group Footer #1 with the text Total for this 

supplier:. Move the summary field into the text object. Format the 
entire object to be Bold, 14 pt., and right aligned. 

 
7. Add a text box to the Group Footer #2 with the text Total for this 

product type:. Move the summary field into the text object. Format the 
entire object to be Bold and right aligned.  

 
8. Format the summary field in the Group Footer #3 section to have a top 

double line border. Make sure the summary field and text boxes are all 
snapped to the guideline on their right edges so they line up. 

 
9. Snap the field titles to a horizontal guideline. Use the guideline to move 

the field names from the Page Header section to the Group Header #3 
section under the Group #3 Name field. Format the titles so they have 
no underline.  
By placing the titles in this section, the titles will reprint with each 
month’s data. 

 
10. Format the Order ID field to display without a comma. Format the Unit 

Price field, the Line Total formula, and all the summary fields to have a 
floating $. 
HINT: Refer to the bullets on page 26 for directions on how to format 
the summary fields inside the text boxes. 

 
11. Depending on how you have the default formats set for Date/Time 

fields; you may need to reformat the Group #3 Name fields. The date 
should look like this: January 2004. 

 
12. From the Special Fields list, add the Page N of M field to the left side 

of the Page Footer. Add a text box on the right side of the page footer 
that reads Order information as of. Add the Data Date special field 
after the text. Format both items to be italisized. 
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13. To add the word "Continued…" for a product or supplier group 
continued on an additional page, place the @Continued formula field in 
the text object containing the Supplier and Product Names. 

 
14. Save and preview the report. Do not forget you can navigate easily 

through the report using the Group Tree section at the left of the 
screen. Just click the group you want to view. Close the report. 

 
The Design view of the report should be similar to the following illustration: 
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Notes Page
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 Lesson Objectives 
 

After completing this lesson, you will be able to: 
 
• Create multiple sections 

Expand your formatting power by learning how to add sections to the 
report 

 
• Underlay a section 

Display a graphic or chart beside the data it represents by utilizing the 
underlay feature 

 
• Use multiple sections for conditional formatting 

Add additional sections that only display under certain conditions 
 
. 
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Using Multiple Sections in Reports 
 

By default, Crystal Reports gives you five design areas to use when 
building your report: Report Header, Page Header, Details, Report Footer, 
and Page Footer. 
 

 
 
Each area contains only a single section when you first begin your report.  
There are certain reporting tasks you can perform most efficiently by 
creating multiple sections within an area, such as: 
 
• Putting conditional messages in form letters 
 
• Formatting objects/sections differently based on field values 
 
• Alternating background colors on a row-by-row basis 
 
• Eliminating blank lines when fields are empty 
 
• Adding blank lines under specific conditions 
 
When you understand the power of multiple sections, you discover many 
ways you can use them to produce the report effects you want. The 
following are some ideas for using multiple sections: 
 
Suppose you want to display current order amounts in the Details section. If 
the customer has outstanding amounts you want to display them as well. 
You add an additional Details section b, and conditionally format to display 
only if there are outstanding order amounts.  
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You are printing an employee listing grouped by Employee Name. You 
have information on each employee, including address, telephone, start 
date and sales for the last month. You also have a field displaying the 
employee's picture you want to shown beside the printed data. You cannot 
put it in the Employee Name group header because it prints above the rest 
of the data and takes up too much space. So, you create a second group 
header section, put the picture there, and then turn on ‘Underlay Following 
Sections’. The picture will then print beside each employee’s data. 
 
You need a single page summary report of the top twenty customers. 
Included in the report, you need a graph showing each region's percent of 
total sales. There is not enough room to print the graph above or below the 
customer listing. You can put the graph in a Report Header b section and 
underlay the section, causing the graph to print along side the data. 
 
Your report prints customer invoices and a list of the orders in the last 
month. You want to include a nice letter to thank paid up customers for 
keeping their account current. For overdue customers, you want a more 
forceful letter asking them for payment. You can create two Group Header 
sections and conditionally suppress each one depending on the condition 
of the account. The Detail section would show all orders currently not paid, 
along with their due dates. 
 
These are only some ideas for using multiple sections. You are going to try 
some of these ideas in following exercises. 

 

Using the Section Expert to Work with Sections 
 

In the Section Expert, you can easily insert, merge and delete sections. 
You can also move sections within an area and conditionally format 
sections. Remember, you can open the Section Expert in three ways: 
 
• Choose Report|Section Expert… 

• Click the Section Expert button  on the Expert Tools toolbar 

• RIGHT click the section name you want to format, then choose Section 
Expert from the shortcut menu 
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In the Section Expert, you can select the section you want to work with in 
the Sections: list, and then use the Insert, Delete, or Merge buttons to 
manipulate additional sections. The arrow buttons allow you to move 
sections within an area. 

 
You can also perform all these section procedures from the Section 
shortcut menu. RIGHT click on the left side of the screen where you see 
the section name of the section you wish to change. The shortcut menu 
contains commands for inserting, merging and deleting sections. 
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WARNING: If there is currently only one section in an area, 
the Merge, Move and Delete commands do not display. You 
only see the Merge command if you RIGHT click on a 
section that has another section of the same type below it. 

 
 
Crystal Reports has a true shortcut for inserting a section below an existing 
section. Left click on the vertical separator bar in the section you wish to 
add. Hold down the mouse button until the mouse pointer changes to a 
double-headed arrow with a single line horizontally separating the arrows.  
Drag the line up or down and release. This method of inserting a new 
section keeps all the formatting from the section above. 
 
 
 



 

 37

Crystal Reports XI Designer 2 Workshop ©2006 Vision Harvest, Inc.
Lesson 2: Power Formatting with Multiple Sections 

 
 Exercise 2.0 – Insert an Additional Report Header Section 

 
1. Create a report of Last Year’s Sales by Country using the Top 

Customer view in the Xtreme Sample Database 11 data source.   
 
2. Group by Country. 
 
3. Insert the Customer Name and Last Year's Sales fields into the Detail 

section. Shorten the fields and move them to the left side of the report. 
 
4. Summarize the Last Year’s Sales field. Move the Group #1 Name field 

from the Group Header into the Group Footer. 
 
5. Change the column title for the Customer Name to Country. 
 
6. Hide the Group Header #1 section and the Details section. 
 
7. Place a text object into the Report Header section with the title Last 

Year’s Sales by Country. Format the title like the illustration on the 
next page.  

 
8. Create a bar chart to display in the Report Header. Open the Chart 

Expert. On the Data tab, graph the groups on change of Country. Set 
the value to Sum of Last Year’s Sales.  This is the default. 

 
9. In the Options tab, set the Bar Size to average and turn off the Legend. 

In the Text tab, remove any text titles by turning off the Auto-Text and 
delete all the text in the labels.  

 
10. On the Color Highlighting tab create a condition that formats the bars all 

one color except for the USA, which should be red. When finished, click 
OK. 

 
11. After Crystal Reports places the graph in the report, move it to the right. 
 
12. Save the report as LYS by Country.rpt and preview the report. 
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The report should be similar to the following illustration: 
 

 
 
 
 

The report would look better if the graph displayed beside the records. You can 
underlay the Report Header to accomplish this. However, if you underlay the entire 
Report Header the title will also display beneath the customer information. We 
need to place the chart in a separate section below the title and then underlay 
Report Header b. 

 
 
13. Return to Design view. 

 
14. Insert a section below the Report Header by right clicking the words Report 

Header and choosing Insert Section Below.  Move the chart to Report 
Header b.  Right click in Report Header a and choose Fit Section. 
 

15. RIGHT click the section name for Report Header b, then choose Section 
Expert. 
Notice the Section Expert now displays both Report Header sections. 
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 Exercise 2.1 – Underlay a Section 
 
1. Click the Underlay Following Sections check box, and then click OK. 
 
2. The use of a second Report Header section also lets you center the report title 

without the under-laid text printing on top of it. Move the title text object to the 
center of the Report Header a. Resize the title as shown in the sample. 

 
3. Save (LYS by Country) and preview the report. 
 

 
The report should look like the following illustration: 
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Conditionally Formatting Multiple Sections 
 

Now that you have a nice looking sales summary report, suppose you want 
to include a congratulations message to those country’s sales reps who 
collectively sold more than $500,000. You want to display the message 
directly under the name and sales figure for the country. 
 
The country name and sales figure are located in the Group Footer 
section.  If you place the text message in the same Group Footer section 
underneath the field objects, it will create additional spacing for each group 
when the text message is suppressed.   
 
To solve this problem, you can add another Group Footer section and then 
add a text object with the message in Group Footer #1b. Then, 
conditionally format to suppress this section if the Sum of Last Year's 
Sales field is less than 500,000.  
 

 Exercise 2.2 – Conditionally Format Multiple Sections 
 
1. Return to Design view. 
 
2. RIGHT click the Group Footer #1 section name, and then choose 

Insert Section Below. 
 
3. Add a text object to the Group Footer #1b section. 
 
4. Type Congratulations to the sales representatives for. Select from 

the Field Explorer, the Group #1 Name Country field and place it into 
the text object. Continue to type You have each won an all expense 
paid trip to St. Thomas! 
Note we have inserted a group name field so that the text reads with the 
correct country inserted. 

 
5. RIGHT click the Group Footer #1b section name, and then choose 

Section Expert. 
 

6. Click the  button to the right of the Suppress (No Drill Down) check 
box. 

 
7. Enter the following formula: 
 

Sum ({Top_Customers.Last Year's Sales}, 
{Top_Customers.Country}) < 500000 

 
8. Select the Save and Close button in the Format Formula Editor. 

Close the Section Expert. Save and preview the report. 
The message should only appear for those countries that have a Sum 
of Last Year's Sales equal to or over $500,000. 
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9. Save the report (LYS by Country).  Your report should look like the 
sample. 
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Challenge Exercise – Formatting with Multiple Sections 
 
  

Suppose you need to create a Quarterly Sales report showing the sales for 
last year (2004). This will be a summary report including a graph of the 
sales for each quarter and the sales totals for each employee. The finished 
report needs to look like the following illustration: 
 

 
 
 
 
1. Start by creating a new report based on the Xtreme Sample Database 

11. Add the Employee and Orders tables. 
 
2. Use the Group Expert to insert a group on the Order Date field. 

Choose to print the group once for each quarter. Insert another group 
on the Last Name field. 

 
3. Select only records in 2004 using the between operator. 
 
4. Put the Order Date field and the Order Amount field into the Details 

section at the RIGHT side of the report.  Put the field headings into 
Group Header 2. 

 
5. Summarize the Order Amount field by Order Date Group (Group #1) 

and by Employee Last Name Group (Group #2). 
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6. Move the Group #1 Name field into the Group Footer #1 and position 
it close to the summary field. You may need to resize it. Do the same 
for the Group #2 Name field (into Group Footer #2). Reformat the 
Group #1 Name field to look like the following:  January 2004. 

 
7. Add the title and the print date to the Report Header section. Format 

them like the example. Add the Xtreme logo.  Add a subtitle “Quarterly 
Sales” as shown in the example. 

 
HINT: Use two text boxes and draw a line between the two text boxes. 
If you want to resize the image you may need to disconnect it from the 
repository before resizing. 

 
8. Suppress the Page Header and hide the Group Header #2 section, the 

Group Footer #2 section and Details section. 
 
9. Now you are ready for the extra sections. The report needs to have a 

graph of the sales by quarter displayed beside the summary values by 
using the underlay feature. Since the graph appears once on the report, 
you need to put it in the Report Header. To accomplish this we need an 
additional Report Header section. Right click on the Report Header 
section name, and then choose Insert Section Below. 

 
 
10. Insert a chart into RHb. Use the Chart Expert to ensure that it is a pie 

chart graphing the Sum of Order Amount by Order Date. On the 
Options tab, display the values and format them to look like currency 
with no decimals ($1). Turn off the Legend. Turn off all the Auto-Text 
entries on the Text tab and delete any text.  If the Sum of Order Amount 
is greater than 800000 then color the piece of pie red. 

 
11. Move the chart to the left of the Report Header b section and resize to 

be only 4” wide.   
 

12. Turn on the Underlay following sections command for Report Header b 
but not for Report Header a. 

 
13. Finally you want to add a title for the quarterly sales figures. Add a text 

object to Report Header a that lines up with the Order Amount 
summary field. Type Total Sales. Format the box to be bold with a 
bottom single border. 
HINT: Since the Order Amount summary field is a number and aligns on 
the right; select both the text object and the summary field, right click on 
the summary field and choose Align>Rights. Right align the text in the 
text object. 

 
14. Save this report and name it Quarterly Sales.rpt. Preview the report. 
 



 

 44

Crystal Reports XI Designer 2 Workshop ©2006 Vision Harvest, Inc.
Lesson 2: Power Formatting with Multiple Sections 
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Challenge Exercise – Conditionally Formatting Using DrillDownGroupLevel

 
 

 
The Quarterly Sales report displays summary level information.  However, 
when you created this report, you included the detailed information.  The 
information in the Group #2 sections and the Details section was hidden in 
the previous exercise.  If you drill down into the report by selecting the 
summary information for January 2004, you will notice the report will 
display column headings for the first drill down. The drill down will look 
similar to the following example: 
 

 
 
 
Obviously we do not want the column headings to appear at this level of 
detail.  However, we do not want to delete them, because they will serve a 
useful purpose when you drill down to the order details for each employee.  
In order to prevent the column headings from appearing at the first drill 
down, we use a formatting option called DrillDownGroupLevel.  By using 
this function in conjunction with conditional suppression of a section, the 
column headings will display at the order detail level, but not at the 
employee summary level. 
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In this exercise, you will format the report to only display the column 
headings at the order detail level. 
 
1. Return to the Design view.  Right click on the Group Header #2 

section and select the Section Expert. 
 

2. Locate the  button beside the Suppress (No Drill-Down) option. 
 

3. The DrillDownGroupLevel function is found in the Print State functions 
list.  The formula for preventing the group level drill down for Group 
Header #2 is as follows: 

 
DrillDownGroupLevel = 1 

 
4. Save and close the Format Formula Editor. 
 
5. Close the Section Expert. 

 
6. Save and Preview the report. 

 
7. On the Preview tab, double click the value for January 2004. 

Notice the information for January 2004 now displays the employees 
and their summary information.  The column headings no longer appear 
at this level of detail. 
 

8. Drill down to view the detail orders for Davolio.  Notice the column 
headings appear above the order date and order amount columns. 
 

9. Save the report (Quarterly Sales) and close. 
 

If you are unsure what the DrillDownGroupLevel value is for the 
group you are working with, create a formula with the 
DrillDownGroupLevel value in it and place it into the header.  
You will then see the value as you drill down.  Once you know 
the value, simply place it into the Section Expert as shown 
above to prevent the heading from displaying on drill down. 
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Challenge Exercise – Conditionally Formatting Multiple Sections 
 

 
Suppose you also want to include a message in the report congratulating all 
the sales reps with sales over $120,000 for each quarter. The message only 
displays when the sales person drills down on the quarter to see employee 
sales for that quarter. You only want the message to appear under the 
employee names meeting the top sales goals for that quarter. The results 
should look like this: 
 

 
 
Since the sales for each employee is a summary field, there is no way to 
compare it with summaries from other groups. So, you need to add the 
message and suppress it based on a combination of which quarter it is and the 
employee name. 
 
1. Return to Design view. 
 
2. RIGHT click the Group Footer #2 section name at the left of the screen, 

and then choose Insert Section Below. 
 
3. Add a text box to the Group Footer #2b section. Type Congratulations, 

and insert the {Employee.First Name} field.  Then type !  You are one of 
the top sales producers for this quarter. 

 
4. Resize the text object so it looks good to you. 
 
5. Now you are ready to conditionally suppress the Group Footer #2b 

section.  RIGHT click the Group Footer #2b section name, and choose 
Section Expert. 

 

6. Click the  button after the Suppress (No Drill Down) check box. 
 
7. Enter the following formula: 
 

Sum ({Orders.Order Amount}, {Employee.Last Name}) < 120000 
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8. Save and close the formula. Close the Section Expert. Save and preview 

the report. Double click on the January 2004 sales to see if the formula 
worked. 

 
9. Save (Quarterly Sales). 
 
The drill-down pages of the report should look similar to the following 
illustration: 
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Notes Page 
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